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Important Information

Warranty
The CAN hardware is warranted against defects in materials and workmanship for a period of one year from the date of
shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace
equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by
receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability
of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any
action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein
does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National
Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse,
misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without
the prior written consent of National Instruments Corporation.

Trademarks
LabVIEW and NI-CAN are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical or
clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the user
or application designer. Any use or application of National Instruments products for or involving medical or clinical
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards,
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always
continue to be used when National Instruments products are being used. National Instruments products are NOT intended
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health
and safety in medical or clinical treatment.



FCC/DOC Radio Frequency Interference
Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict
accordance with the instructions in this manual, may cause interference to radio and television reception.
Classification requirements are the same for the Federal Communications Commission (FCC) and the
Canadian Department of Communications (DOC). This equipment has been tested and found to comply
with the following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables of
suitable quality and construction. National Instruments used such cables to test this
device and provides them for sale to the user. The use of inferior or nonshielded
interface cables could void the user's authority to operate the equipment under the
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel
brouilleur du Canada.
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About
This

Manual

This manual contains instructions to help you install and configure the
National Instruments CAN hardware and the NI-CAN software for
Windows NT. The National Instruments CAN hardware supported under
Windows NT includes the PCI-CAN and PCI-CAN/2.

This manual assumes that you are already familiar with Windows NT.
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Use this getting started manual to install and configure your CAN
hardware and the NI-CAN software for Windows NT.

Use the NI-CAN User Manual for Windows 95 and Windows NT to learn
the basics of CAN and how to develop an application program. The user
manual also contains debugging information and detailed examples.

Use the NI-CAN Programmer Reference Manual for Win32 for specific
information about each NI-CAN function and object, such as format,
parameters, and possible errors.

Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what
you need to get started and optional equipment you can order, and
briefly describes the CAN hardware and the NI-CAN software for
Windows NT.

• Chapter 2, Installation and Configuration, describes how to install
and configure the CAN hardware and the NI-CAN software for
Windows NT.

• Chapter 3, Verify the Installation, describes how to verify the
hardware and software installation.

• Chapter 4, Begin to Use the NI-CAN Software, helps you get started
with the NI-CAN software for Windows NT.

• Appendix A, Uninstall the Hardware and Software, describes how
to uninstall the CAN hardware and the NI-CAN software from
Windows NT.

• Appendix B, Cabling Requirements, describes the cabling
requirements for CAN interfaces.

• Appendix C, Troubleshooting and Common Questions, describes
how to troubleshoot problems and answers some common questions.

• Appendix D, Specifications, describes the physical characteristics of
the CAN hardware, along with the recommended operating
conditions.

• Appendix E, Customer Communication, contains forms you can use
to request help from National Instruments or to comment on our
products and manuals.
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• The Glossary contains an alphabetical list and a description of terms
used in this manual, including abbreviations, acronyms, metric
prefixes, mnemonics, and symbols.

Conventions Used in This Manual
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box
options to a final action. The sequence File»Page Setup»Options»
Substitute Fonts directs you to pull down the File menu, select the
Page Setup item, select Options, and finally select the Substitute Fonts
options from the last dialog box.

bold Bold text denotes the names of menus, menu items, parameters, dialog
boxes, dialog box buttons or options, icons, windows, Windows NT tabs,
or LEDs.

bold italic Bold italic text denotes a note or warning.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key
concept. This font also denotes text for which you supply the appropriate
word or value, such as in Windows 3.x.

italic monospace Italic text in this font denotes that you must supply the appropriate words
or values in the place of these items.

monospace Text in this font denotes text or characters that you should literally enter
from the keyboard, sections of code, programming examples, and syntax
examples. This font is also used for the proper names of disk drives,
paths, directories, programs, subprograms, subroutines, device names,
functions, operations, variables, filenames, and extensions, and for
statements and comments taken from program code.

paths Paths in this manual are denoted using backslashes (\) to separate drive
names, directories, folders, and files.
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Related Documentation
The following documents contain information that you may find helpful
as you read this manual:

• ANSI/ISO Standard 11898-1993, Road Vehicles—Interchange of
Digital Information—Controller Area Network (CAN) for
High-Speed Communication

• CAN Specification Version 2.0, 1991, Robert Bosch Gmbh.,
Postfach 500, D-7000 Stuttgart 1

• CiA Draft Standard 102, Version 2.0, CAN Physical Layer for
Industrial Applications

• DeviceNet Specification, Volume 1, Version 1.3, Open DeviceNet
Vendor Association

• Microsoft Windows NT User's Guide, Microsoft Corporation

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with
our products, and we want to help if you have problems with them. To
make it easy for you to contact us, this manual contains comment and
configuration forms for you to complete. These forms are in Appendix E,
Customer Communication, at the end of this manual.
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Introduction
1

Chapter

This chapter explains how to use this manual, lists what you need to get
started and optional equipment you can order, and briefly describes the
CAN hardware and the NI-CAN software for Windows NT.
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What You Need to Get Started
Make sure you have all of the following items before you attempt to
install the hardware and software:

❑ Windows NT 3.51 or higher installed on your computer

❑ One of the following CAN interfaces:

PCI-CAN
PCI-CAN/2

❑ The following 3.5 in., high density (1.44 MB) disks, which are
included in your kit:

NI-CAN Software for Windows 95 and Windows NT (Disk 1)

NI-CAN Software for Windows 95 and Windows NT (Disk 2)

❑ CAN interface cables that meet the requirements in Appendix B,
Cabling Requirements

CAN Hardware Overview
The National Instruments CAN hardware includes the AT-CAN,
AT-CAN/2, PCI-CAN, and PCI-CAN/2.

The AT-CAN and AT-CAN/2 are not supported under Windows NT.

The PCI-CAN and PCI-CAN/2 are software configurable under
Windows NT and are compliant with the PCI Local Bus Specification.
The PCI-CAN and PCI-CAN/2 allow any PC AT-compatible computer
with PCI Local Bus slots to communicate with and control CAN devices.

The PCI-CAN boards have one CAN port and the PCI-CAN/2 boards
have two CAN ports.

CAN interfacing is accomplished using the Intel 82527 CAN controller
chip. The PCI-CAN physical layer fully conforms to the ISO 11898
physical layer specification for CAN and is optically isolated to 500 V.
The PCI-CAN also meets the electrical requirements of DeviceNet by
powering the CAN physical layer from the CAN bus. PCI-CAN boards
are available with two physical connector types:  DB-9 D-Sub (for
non-DeviceNet applications) and Combicon-style pluggable screw
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terminals (as required by the DeviceNet specification). The CAN
hardware supports a wide variety of transfer rates up to 1 Mbytes/s.

All of the CAN hardware uses the Intel 386EX embedded processor to
implement time-critical features provided by the NI-CAN software. The
CAN hardware communicates with the NI-CAN driver through on-board
shared memory and an interrupt.

NI-CAN Software Overview
The NI-CAN software includes a native, 32-bit multitasking
Windows NT kernel driver.

The NI-CAN software for Windows NT supports the concurrent use of
multiple types of CAN hardware. For example, you can communicate
with CAN devices through both a PCI-CAN and PCI-CAN/2 in the same
system at the same time. The NI-CAN software is fully integrated into the
Windows NT operating system. It is configurable through the
Windows NT Control Panel and uninstallable through the Add/Remove
Programs applet of the Control Panel.

The NI-CAN software, along with the CAN hardware, transforms your
computer into a CAN interface with complete communications and bus
management capability. The NI-CAN software includes the following
components:

• Firmware (runs on embedded Intel 386EX)

• Device driver

• Diagnostic test utility

• Configuration utility

• Language interface libraries for Microsoft Visual C/C++ 2.0 or
higher, LabWindows/CVI 4.0 or higher, and LabVIEW 4.0 or
higher

• Example programs that use NI-CAN functions

Optional Programming Tools
Your kit includes the NI-CAN software for Windows NT. In addition,
you can order the LabWindows/CVI or LabVIEW software from
National Instruments.
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LabWindows/CVI is an interactive ANSI C development environment
for building test and measurement and instrument control systems. It
includes interactive code-generation tools and a graphical editor for
building custom user interfaces. It also includes built-in libraries for
IEEE 488.2, VXI, RS-232 control, and plug-in data acquisition. When
you order LabWindows/CVI, you also get hundreds of complete
instrument drivers, which are modular, source-code programs that handle
the communication with your instrument so that you do not have to learn
the programming details.

LabVIEW is a complete programming environment that departs from
the sequential nature of traditional programming languages and features
a graphical programming environment. It includes all the tools needed
for instrument control, data acquisition, analysis, and presentation.
LabVIEW also includes an extensive instrument driver library.

For more information about LabWindows/CVI and LabVIEW, contact
National Instruments.
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Installation and
Configuration

2
Chapter

This chapter describes how to install and configure the CAN hardware
and the NI-CAN software for Windows NT.

Install the NI-CAN Software
Before installing the CAN hardware, complete the following steps to
install the NI-CAN software for Windows NT.

Installing for Windows NT 3.51
1. Log in as Administrator  or as a user that has Administrator

privileges.

2. Insert the NI-CAN Software for Windows 95 and Windows NT
(Disk 1) into an unused drive.

3. In the Run... dialog box, type the following:

x:\setup

where x  is the letter of the drive containing the disk (usually a or b).

4. Shut down your computer when the setup is complete.

Installing for Windows NT 4.0
1. Log in as Administrator  or as a user that has Administrator

privileges.

2. Select Start»Settings»Control Panel.

3. Double-click on the Add/Remove Programs icon in the Control
Panel to launch the Add/Remove Programs applet. A dialog box
similar to the one in Figure 2-1 appears.
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Figure 2-1.  Add/Remove Programs Properties Dialog Box

You can use this same applet to uninstall the NI-CAN software at a
later time. Refer to Appendix A, Uninstall the Hardware and
Software, for more information.

4. Click on the Install... button.

5. Insert the NI-CAN Software for Windows 95 and Windows NT
(Disk 1), and click on the Next button to proceed. The software
installation wizard begins with the screen shown in Figure 2-2.
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Figure 2-2.  NI-CAN Software Setup Screen

The setup wizard guides you through the necessary steps to install
the NI-CAN software. You may go back and change values where
appropriate by clicking on the Back button. You can exit the setup
where appropriate by clicking on the Cancel button.

6. Shut down your computer when the setup is complete.

Install the CAN Hardware
This section describes how to install your CAN hardware.

Install Your CAN Interface
Warning: Electrostatic discharge can damage several components on these CAN

interfaces. To avoid such damage in handling your interface, touch the
antistatic plastic package to a metal part of your computer chassis before
removing the interface from the package.

1. Make sure that your computer is turned off. Keep the computer
plugged in so that it remains grounded while you install the CAN
interface.

2. Remove the top cover (or other access panels) to give yourself access
to the computer expansion slots.
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3. Find an unused expansion slot of the appropriate type in your
computer.

4. Remove the corresponding slot cover on the back panel of the
computer.

5. Insert the CAN interface into the slot with the CAN connector(s)
sticking out of the opening on the back panel. It might be a tight fit,
but do not force the interface into place. Figure 2-3 shows how to
install the PCI-CAN into a PCI expansion slot.

Figure 2-3.  Installing the PCI-CAN

6. Screw the mounting bracket of the CAN interface to the back panel
rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Turn on your computer and start Windows NT.
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Connect the Cables
Because exact cabling requirements vary for each application, National
Instruments does not provide cables. Refer to Appendix B, Cabling
Requirements, for information about the cabling requirements of the
CAN hardware.

After you have installed the CAN interface as described in the previous
section, connect your CAN cables to the interface. The CAN hardware
installation is now complete. Proceed to the next section, Configure the
NI-CAN Software.

Configure the NI-CAN Software
The NI-CAN Configuration utility is located in the Windows NT Control
Panel. You can use it to examine or modify the configuration of the
NI-CAN software. The context-sensitive online help, available by
right-clicking on any of the controls on the configuration utility buttons,
includes all of the information that you need to configure the NI-CAN
software properly.

To use the NI-CAN Configuration utility, you must first log in as
Administrator  or as a user that has Administrator privileges. To
configure the NI-CAN software, double-click on the NI-CAN
Configuration  icon in the Control Panel:

• Windows NT 3.51:  Open the Control Panel in the Main group of
the Program Manager.

• Windows NT 4.0 or higher:  Select Start»Settings»Control Panel.

Figure 2-4 shows a CAN interface that is working properly. If no
interfaces are listed under NI-CAN Configuration , refer to the
Missing CAN Interface in the NI-CAN Configuration Utility section in
Appendix C, Troubleshooting and Common Questions, to resolve the
problem.
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Figure 2-4.  CAN Interface That Is Working Properly

To select a particular interface, click on that interface in the list.

When you install the PCI-CAN or PCI-CAN/2, your computer
automatically assigns valid resources to it. Because this resource
assignment is automatic, you do not need to use the Resources dialog
box for the PCI-CAN or PCI-CAN/2, and you do not need to restart
Windows NT.

Click on the Settings button to view information about the NI-CAN
software configuration for the CAN interface. Figure 2-5 shows the
Settings dialog box.
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Figure 2-5.  NI-CAN Settings for the PCI-CAN/2

Each port of the CAN hardware interface is configured from this tab. Use
the drop-down box nearest the top of the tab to select the physical port
number to configure. For each port, use the Name drop-down box to
select the name for the CAN Network Interface Object (CAN0, CAN1, and
so on). You use this name to refer to the physical port from within your
NI-CAN application.

To access online help for the NI-CAN Configuration utility, click on the
Help button. Alternately, you can right-click on a specific control and
select What’s This? from the pop-up menu to see context-sensitive help
for the item you have clicked on.

When you have finished configuring the NI-CAN software, proceed to
Chapter 3, Verify the Installation.
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Verify the Installation
3

Chapter

This chapter describes how to verify the hardware and software
installation.

You can use the NI-CAN Diagnostic utility, installed with your NI-CAN
software, to test the hardware and software installation. The utility
verifies that your hardware and software are functioning properly and
that the configuration of your CAN interfaces does not conflict with
anything else in your system.

To run the utility, select the NI-CAN Diagnostic item:

• Windows NT 3.51:  Double-click on the NI-CAN Diagnostic icon in
the NI-CAN Software for Windows NT group of the Program
Manager.

• Windows NT 4.0 or higher:  Select Start»Programs»NI-CAN
Software for Windows NT»NI-CAN Diagnostic.

When you have started the NI-CAN Diagnostic utility, test your CAN
interfaces by clicking on the Test All button. You can also test one CAN
interface by highlighting it and clicking on the Test One button. If the
NI-CAN Diagnostic is successful, it puts a checkmark next to the
interface and changes its status from Untested to Passed. If the NI-CAN
Diagnostic fails, it puts an X next to the interface, and changes its status
from Untested to Failed. Figure 3-1 shows the NI-CAN Diagnostic
utility after it has tested some CAN interfaces.
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Figure 3-1.  NI-CAN Diagnostic Utility after Testing

You can get details on any tested CAN interface by selecting the interface
and clicking on the Details button. For each failed CAN interface, select
it and click on the Details button to get a description of the failure. Use
that information and the information in Appendix C, Troubleshooting
and Common Questions, to troubleshoot the problem. Troubleshooting
information is also available in the online help for the NI-CAN
Diagnostic utility, which you can access by clicking on the Help button.
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Begin to Use the
NI-CAN Software

4
Chapter

This chapter helps you get started with the NI-CAN software for
Windows NT.

Using the NI-CAN Software
The functions provided by the NI-CAN software are similar to those
provided by many other device drivers. For example, NI-CAN has open,
close, read, and write functions. NI-CAN provides two different levels of
access to a CAN network:  the CAN Network Interface Object, and CAN
Objects. Both forms of access support timestamping of incoming data, as
well as various forms of queuing.

The CAN Network Interface Object provides low-level access to a CAN
network. Each CAN Network Interface Object maps to a specific CAN
port, with no limitation on the maximum number of ports or cards you
can use (for example, two PCI-CAN/2 interfaces would provide CAN0

through CAN3). You can use this object to transmit and receive entire
CAN frames. For example, to transmit a CAN frame, you would specify
the outgoing arbitration ID, frame type (data or remote), data length, and
data.

The CAN Objects provide higher level access to a CAN network. Each
CAN Object maps to a specific data item (arbitration ID), and you can
use multiple CAN Objects for a given port. When configuring a CAN
Object for use, you specify the arbitration ID, direction of data transfer,
data length, and how you want the data to be accessed (such as
periodically). For example, you could configure a CAN Object to
transmit an outgoing data frame for a specific arbitration ID every
100 ms. After opening this CAN Object, you use the write function to
provide data to transmit, and the NI-CAN embedded firmware handles
all periodic timing.
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For detailed information about the NI-CAN software and functions, refer
to the NI-CAN User Manual for Windows 95 and Windows NT and the
NI-CAN Programmer Reference Manual for Win32.

General Programming Considerations
As you begin developing your Win32 NI-CAN application, remember the
following points:

• For your LabVIEW application, you must use the NI-CAN
LabVIEW functions in nican.llb .

• For your C/C++ application, you must include the NI-CAN header
file, nican.h , in your source code.

• The NI-CAN software is accessed through the 32-bit DLL,
nican.dll , either by linking with one of the language interfaces
provided with the NI-CAN software, or by using direct DLL entry
from other programming environments.

• Several sample CAN applications are included with the NI-CAN
software. Use these as a guide for your own application
development.

For information about developing your application, refer to the NI-CAN
User Manual for Windows 95 and Windows NT. For detailed information
about NI-CAN functions and objects, refer to the NI-CAN Programmer
Reference Manual for Win32.



© National Instruments Corporation A-1 Getting Started with CAN for Windows NT

Uninstall the Hardware
and Software

A
Appendix

This appendix describes how to uninstall the CAN hardware and the
NI-CAN software from Windows NT.

Uninstalling the CAN Hardware from Windows NT
Because the current version of Windows NT does not maintain hardware
information for the CAN interfaces, you just need to physically remove
the CAN interfaces from your computer. To do so, shut down
Windows NT, power off your computer, and physically remove the
CAN interfaces.

Uninstalling the NI-CAN Software from Windows NT

Note: The following instructions apply to Windows NT 4.0 only. If you are
using Windows NT 3.51, refer to the readme.txt  file in your NI-CAN
directory for information on how to uninstall the NI-CAN software.

Before uninstalling the NI-CAN software, you should remove all CAN
interface hardware from your computer, as explained in the previous
section.

Complete the following steps to remove the NI-CAN software:

1. Select the Add/Remove Programs icon under
Start»Settings»Control Panel. A dialog box similar to the one in
Figure A-1 appears. This dialog box lists the software available for
removal.
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Figure A-1.  Add/Remove Programs Properties Dialog Box

2. Select the NI-CAN software you want to remove, and click on the
Add/Remove... button. The uninstall program runs and removes all
folders, utilities, device drivers, DLLs, and registry entries associated
with the NI-CAN software. Figure A-2 shows the results of a
successful uninstallation.
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Figure A-2.  NI-CAN Uninstallation Results

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the
installation program, the uninstall program does not delete that directory,
because the directory is not empty after the uninstallation. You need to
remove any remaining components yourself.

If you want to reinstall the hardware and software, refer to Chapter 2,
Installation and Configuration.
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Cabling Requirements
B

Appendix

This appendix describes the cabling requirements for CAN interfaces.

Cables should be constructed to meet these requirements, as well as the
requirements of the other CAN or DeviceNet devices in the network.

Connector Pinouts
Depending on the type of CAN interface you are installing, it either has
DB-9 D-Sub connectors(s), or Combicon-style pluggable screw terminal
connector(s).

The 9-pin D-Sub follows the pinout recommended by CiA DS 102.
Figure B-1 shows the pinout for this connector.

1
2

3
4

5

6
7

8
9

No Connection

CAN_L

V-

No Connection

No Connection

CAN_H

No Connection

V+
Shield

Figure B-1.  Pinout for 9-Pin D-Sub Connector
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The 5-pin Combicon-style pluggable screw terminal follows the pinout
required by the DeviceNet specification. Figure B-2 shows the pinout for
this connector.

C
A

N
_L

V
-

C
A

N
_H

V
+

S
hi

el
d

1 2 3 4 5

Figure B-2.  Pinout for 5-Pin Combicon-Style Pluggable Screw Terminal

CAN_H and CAN_L are signal lines that carry the data on the CAN
network. These signals should be connected using twisted-pair cable.

V+ and V- supply power to the CAN physical layer. See the next section,
Power Supply Information for the CAN Ports, for more information.

Power Supply Information for the CAN Ports
The bus must supply power to each CAN port. The bus power supply
should be a DC power supply with an output of 10 V to 30 V. The CAN
physical layer is powered from the bus using the V+ and V- lines.

The power requirements for the CAN ports are shown in Table B-1. You
should take these requirements into account when determining the
requirements of the bus power supply for the system.

Table B-1.  Power Requirements for the CAN Physical Layer

Characteristic Specification

Voltage Requirement V+ 10-30 VDC

Current Requirement 40 mA typical
75 mA maximum
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Cable Specifications
Cables should meet either the physical medium requirements specified in
ISO 11898 shown in Table B-2 or the requirements of the DeviceNet
cable specification.

Belden cable (3084A) meets these requirements, and should be suitable
for most applications.

Table B-2.  ISO 11898 Specifications for Characteristics of a CAN_H
and CAN_L Pair of Wires

Characteristic Value

Impedance 108 Ω minimum, 120 Ω nominal,
132 Ω maximum

Length-related resistance 70 mΩ/m nominal

Specific line delay 5 ns/m nominal

Cable Lengths
The allowable cable length is affected by the characteristics of the
cabling and the desired bit transmission rates. Detailed cable length
requirements can be found in the ISO 11898, CiA DS 102, and
DeviceNet specifications.

ISO 11898 specifies 40 m total cable length with a maximum stub length
of 0.3 m for a bit rate of 1 Mbytes/s. The ISO 11898 specification says
that significantly longer cable lengths may be allowed at lower bit rates,
but each node should be analyzed for signal integrity problems.

Table B-3 lists the DeviceNet cable length specifications.

Table B-3.  DeviceNet Cable Length Specifications

Bit Rate Thick Cable Thin Cable

500 kb/s 100 m 100 m

250 kb/s 200 m 100 m

100 kb/s 500 m 100 m
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Maximum Number of Devices
The maximum number of devices that you can connect to a CAN port
depends on the electrical characteristics of the devices on the network. If
all of the devices meet the requirements of ISO 11898, at least 30 devices
may be connected to the bus. Higher numbers of devices may be
connected if the electrical characteristics of the devices do not degrade
signal quality below ISO 11898 signal level specifications. If all of the
devices on the network meet the DeviceNet specifications, 64 devices
may be connected to the network.

Cable Termination
The pair of signal wires (CAN_H and CAN_L) constitutes a transmission
line. If the transmission line is not terminated, each signal change on the
line causes reflections that may cause communications failures.

Because communication flows both ways on the CAN bus, CAN requires
that both ends of the cable be terminated. However, this requirement does
not mean that every device should have a termination resistor. If multiple
devices are placed along the cable, only the devices on the ends of the
cable should have termination resistors. See Figure B-3 for an example of
where termination resistors should be placed in a system with more than
two devices.

120 Ω 120 Ω

CAN_H

CAN_L
CAN

Device

CAN
Device

CAN
Device

CAN
Device

Figure B-3.  Termination Resistor Placement
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The termination resistors on a cable should match the nominal impedance
of the cable. ISO 11898 requires a cable with a nominal impedance of
120 Ω; therefore, a 120 Ω resistor should be used at each end of the
cable. Each termination resistor should each be capable of dissipating
0.25 W of power.

Cabling Example
Figure B-4 shows an example of a cable to connect two CAN devices.

9-Pin
D-Sub

9-Pin
D-Sub

CAN_H

CAN_L

GND

V+

V+

V–

V–

5-Pin
Combicon

5-Pin
Combicon

Pin 7Pin 4 Pin 7 Pin 4

Pin 2 Pin 2

Pin 5 Pin 3

Pin 9 Pin 5

Pin 3 Pin 1

Pin 2Pin 2

Pin 5Pin 3

Pin 9Pin 5

Pin 3Pin 1

120Ω 120Ω

Power
Connector

CAN_H and CAN_L should be
connected using twisted-pair cable.

Figure B-4.  Cabling Example
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Troubleshooting and
Common Questions

C
Appendix

This appendix describes how to troubleshoot problems and answers some
common questions.

Missing CAN Interface in the NI-CAN Configuration
Utility

The NI-CAN Configuration utility contains configuration information for
all of the CAN hardware it is aware of that is installed in your system. To
start the NI-CAN Configuration utility, double-click on the NI-CAN
Configuration  icon in the Control Panel:

• Windows NT 3.51:  Open the Control Panel in the Main group of
the Program Manager.

• Windows NT 4.0 or higher:  Select Start»Settings»Control Panel.

If the CAN interface you are looking for is not listed under NI-CAN
Configuration , the CAN interface is not properly installed. For National
Instruments CAN hardware, this means that the interface is not physically
present in the system. If the interface is firmly plugged into its slot and
the problem persists, contact National Instruments.

Troubleshooting Diagnostic Utility Failures
The following sections explain common error messages generated by the
NI-CAN Diagnostic utility.

Resource Errors
Because the resources of PCI-CAN and PCI-CAN/2 boards are assigned
by your computer as it boots, these resource errors are rare. However, if
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a resource error occurs, click on the Resources button in the NI-CAN
Configuration utility to view the board resources. If legacy boards in your
system are using the resources, change the resource configuration of the
legacy board. If the problem persists, contact National Instruments.

NI-CAN Software Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects that it is unable
to communicate correctly with the CAN hardware using the installed
NI-CAN software. If you get this error, shut down your computer, restart
it, and run the NI-CAN Diagnostic utility again. If the problem persists,
try reinstalling the NI-CAN software for Windows NT.

Missing CAN Interface
If a National Instruments CAN interface is physically installed in your
system, but is not listed in the NI-CAN Diagnostic utility, check to see if
the NI-CAN Configuration utility has detected the hardware. For more
information, refer to the Missing CAN Interface in the NI-CAN
Configuration Utility section earlier in this appendix.

CAN Hardware Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects a defect in the
CAN hardware. If you get this error, write down the numeric code shown
with the error, and contact National Instruments. Depending on the cause
of the hardware failure, you may need to repair or replace your CAN
interface.

Common Questions
How can I determine which type of CAN hardware I have installed?

Run the NI-CAN Configuration utility. To run the utility, select
Start»Settings»Control Panel»NI-CAN Configuration. If any CAN
hardware is correctly installed, it is listed under National Instruments
CAN Interfaces.

How do I connect a CAN cable to my CAN interface?

For information about cabling requirements for National Instruments
CAN hardware, refer to Appendix B, Cabling Requirements.
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How can I determine which version of the NI-CAN software I have
installed?

Run the NI-CAN Diagnostic utility. To run the utility, select the NI-CAN
Diagnostic item under Start»Programs»NI-CAN Software for
Windows NT. The NI-CAN Diagnostic utility displays information about
the version of the NI-CAN software currently installed.

Which CAN interfaces does the NI-CAN software for Windows NT
support?

The NI-CAN software for Windows NT supports the PCI-CAN and
PCI-CAN/2.

What do I do if the NI-CAN Diagnostic utility fails with an error?

Refer to the Troubleshooting Diagnostic Utility Failures section in this
appendix for specific information about what might cause the NI-CAN
Diagnostic utility to fail. If you have already completed the
troubleshooting steps, fill out the forms in Appendix E, Customer
Communication, and contact National Instruments.

How many CAN boards can I configure for use with my NI-CAN
software for Windows NT?

The NI-CAN software for Windows NT can be configured to
communicate with up to 10 CAN boards.

Are interrupts required for the NI-CAN software for Windows NT?

Yes, one interrupt per board is required.

How do I use an NI-CAN language interface?

For information about using NI-CAN language interfaces, refer to
Chapter 3, Developing Your Application, in the NI-CAN User Manual for
Windows 95 and Windows NT.

How do I use NI-CAN from within LabVIEW?

For information about using NI-CAN from within LabVIEW, refer to
Chapter 3, Developing Your Application, in the NI-CAN User Manual for
Windows 95 and Windows NT.
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Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the
installation program, the uninstall program does not delete that directory,
because the directory is not empty after the uninstallation. You will need
to remove any remaining components yourself.

What information should I have before I call National Instruments?

When you call National Instruments, you should have all of the
information filled out on the Hardware and Software Configuration
Form in Appendix E, Customer Communication.
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Specifications
D

Appendix

This appendix describes the physical characteristics of the CAN
hardware, along with the recommended operating conditions.

Table D-1.  PCI-CAN and PCI-CAN/2 Hardware Characteristics

Characteristic Specification

Dimensions 10.67 by 17.46 cm
(4.2 by 6.88 in.)

Power Requirement
(from PCI Bus)

+5 VDC 775 mA typical

I/O Connector 9-pin D-Sub for each port (standard)
or
5-pin Combicon-style pluggable
DeviceNet screw terminal

Operating Environment
  Ambient Temperature
  Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
  Temperature
  Relative Humidity

-20° to 70° C
5% to 90%, noncondensing

EMI FCC Class A compliant

Table D-2.  CAN Port Characteristics

Characteristic Specification

Power Requirement 10-30 V 40 mA typical
75 mA maximum

Isolation 500 VDC optical
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Customer Communication
E

Appendix

For your convenience, this appendix contains forms to help you gather the information necessary to
help us solve technical problems and a form you can use to comment on the product documentation.
When you contact us, we need the information on the Technical Support Form and the configuration
form, if your manual contains one, about your system configuration to answer your questions as
quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
quickly provide the information you need. Our electronic services include a bulletin board service,
an FTP site, a Fax-on-Demand system, and e-mail support. If you have a hardware or software
problem, first try the electronic support systems. If the information available on these systems does
not answer your questions, we offer fax and telephone support through our technical support
centers, which are staffed by application engineers.

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded instructions on
how to use the bulletin board and FTP services and for BBS automated information, call
(512) 795-6990. You can access these services at:

United States:  (512) 794-5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635  551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.



Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
wide range of technical information. You can access Fax-on-Demand from a touch-tone telephone at
(512) 418-1111.

E-Mail Support (currently U.S. only)
You can submit technical support questions to the applications engineering team through e-mail at
the Internet address listed below. Remember to include your name, address, and phone number so
we can contact you with solutions and suggestions.

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country, contact
the source from which you purchased your software to obtain support.

Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 527 2321 09 502 2930
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 5734815 03 5734816
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
U.K. 01635 523545 01635 523154



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing this
form accurately before contacting National Instruments for technical support helps our applications
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Fax ( ____  ) _________________________ Phone ( ____ ) ___________________________

Computer brand ___________________ Model ______________ Processor ________________

Operating system (include version number) ____________________________________________

Clock Speed ________ MHz RAM _________ MB Display adapter ________________

Mouse ____ yes _____ no Other adapters installed _____________________________

Hard disk capacity ________  MB Brand ____________________________________________

Instruments used __________________________________________________________________

National Instruments hardware product model _____________________ Revision ____________

Configuration ____________________________________________________________________

National Instruments software product ___________________________ Version ____________

Configuration ____________________________________________________________________

The problem is ___________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

List any error messages ____________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

The following steps will reproduce the problem _________________________________________

________________________________________________________________________________

________________________________________________________________________________



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item.
Complete a new copy of this form each time you revise your software or hardware configuration,
and use this form as a reference for your current configuration. Completing this form accurately
before contacting National Instruments for technical support helps our applications engineers answer
your questions more efficiently.

National Instruments Products

General Information
CAN Interface Type (such as PCI-CAN/2)  ____________________________________________

NI-CAN Diagnostic Utility Results   __________________________________________________

Version Information
To access complete version information, including the hardware version and the NI-CAN driver
version, open the MS-DOS Prompt and change to the NI-CAN installation directory (usually
c:\nican ). At the prompt, enter the following command:

candiag -v

NI-CAN Diagnostic Version Information  _____________________________________________

_______________________________________________________________________________

Other Products

Programming Environment Information
Programming Language   __________________________________________________________

Compiler Vendor                                                Compiler Version _______________________

Application Information
LabVIEW Application                                       Win32 Application ______________________

If Win32, method of accessing DLL (link with language interface or direct entry?)

_______________________________________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products.
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your CAN Hardware and the NI-CAN Software for Windows NT

Edition Date: February 1997

Part Number: 321372A-01

Please comment on the completeness, clarity, and organization of the manual.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

Thank you for your help.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Phone ( ____  ) ________________________  Fax ( _____ ) ___________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway (512) 794-5678
Austin, TX 78730-5039
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Glossary

Prefix Meaning Value

m- milli- 10-3

c- centi- 10-2

k- kilo- 103

M- mega- 106

° degrees

Ω ohms

% percent

A amperes

AC alternating current

AT-compatible compatible with the 16-bit Industry Standard Architecture

b bits

B bytes

C Celsius

CAN Controller Area Network

CiA CAN in Automation

DLL dynamic link library
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DMA direct memory access

EMI electromagnetic interference

FCC Federal Communications Commission

Hz hertz

in. inches

IRQ interrupt request

ISA Industry Standard Architecture

ISO International Standards Organization

m meters

PC personal computer

PCI peripheral component interconnect

PnP Plug and Play

RAM random-access memory

resource hardware settings used by National Instruments CAN hardware,
including an interrupt request level (IRQ) and an 8 KB physical memory
range (such as D0000 to D1FFF hex)

s seconds

V volts

VDC volts direct current

W watts
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